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Adobe InDesign | Introduction

Adobe InDesign is an excellent design tool and 
layout program used for the creation of any type of 
documents whether for print or digital publishing and 
is the tool of choice amongst designers worldwide.

InDesign provides tools for drawing, editing text and 
shapes and includes a comprehensive range of panels to 
allow you to control every aspect of document creation,

It’s excellent typographic controls allow for superb text 
handling an control, allowing your to quickly import, format 
and create a complete documents quickly and efficiently.

Adobe InDesign includes the internationally accepted 
colour management Pantone to ensure accuracy when 
reproducing colour in print, as well as other colour 
models for creating web or digital documents.

This guide is by no means a complete guide to using 
InDesign but provides a comprehensive introduction 
to the main tools, panels and menu's you'll need 
to create all type of documents including Adverts, 
Leaflets, Brochures for publishing in print.
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Designing document layouts is a skill that has to be learnt. 
InDesign is merely the tool to assist in the application of 
that skill. It will not turn you into a great designer overnight 
but it various tools ensure you will achieve results quickly.

Your company may already have Corporate Design 
Guidelines – if so then it should be straightforward 
to produce documents which conform to these rules 
on layout and design as specified in the  corporate 
identity manual. To enable you to conform to these 
standards when using InDesign, design templates 
can be set up for the various types of document.

Before you start to create a document think about what 
it is you are trying to achieve; who the audience is, what 
the subject matter is, what conditions the document 
will be read under, how it will be bound and presented 
or printed. The target audience should always be of 
prime consideration and will therefore affect document 
design. For example  a document to promote or 
advertise a specific product  will be radically different 
from one for use in by technicians or internal use.. 

Try to do a thumb-nail sketch or Comp* of your 
layout so that you can get an overall view of how to 
layout columns of text, pictures, and ruling lines. 

Layout is similar to putting together a jigsaw puzzle. It 
is always worth planning – have all the elements you 
are likely to need ready. Assemble of the elements 
roughly at first (if you try to make it completely accurate 
you will most likely have to alter it if something does 
not fit) – when all the elements are in place and look 
like they will fit, then and only then start to finalise a 
layout, by fine tuning and positioning  accurately.

Keep it simple
• Use only two or three typefaces at most.

• Don't have too many type sizes

• Make style decisions in advance

• Balance column width with type size

• Plan all elements within a job

• Prepare the picture and text files

Approach to Document LayoutTIP
For easy reading, it 

has been shown that  

columns should be 

used, but a highly 

motivated audience 

will be able to read 

wide or single column 

publications.

TIP
Never rely on placing 

images or text by 

eye – you are unlikely 

to be accurate – 

measurement and 

arithmetic are the 

only dependable 

allies! Whilst it may 

look OK on screen 

when output to a 

high quality PDF you 

will only then notice 

irregularities. That is 

why it’s useful to use 

the margin, ruler guides 

and grids to assist.
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Adobe InDesign | Fundamentals7

InDesign is the frame based system. Before you can begin 
working a frame to hold content must be created. Text 
frames holds text content, and a Rectangle Frame holds 
pictures or graphic images. Frames may be grouped, 
ungrouped, resized, moved, or deleted to offer complete 
flexibility. Text boxes can be linked to each other to allow 
uninterrupted text flow. Both text frames and picture boxes 
can contain other framed content and graphics or lines.

A fundamental which should be emphasized is 
that each time a keyboard return is made, it is 
treated as a paragraph. This will become important 

later when using paragraph formatting to provide 
greater precision and improved productivity.

The Default Master Page that is setup right at the beginning 
of document creation, includes items that appear on every 
page of your document such as margin and ruler guides.

Running headers and footers could be placed on a master 
page and any repeating logos or other graphic items 
including page numbering. Any number of master pages 
can be created to accommodate the most exacting design.

InDesign Fundamentals
TIP

Try to balance the type 

size with the size of 

column to achieve 

optimum line breaks 

in justified text.

The Menus

InDesign menu commands are accessed by placing the pointer over 
the required menu and click once depressing the mouse button and 
highlighting the relevant command – then releasing the mouse.

Menu commands that are dimmed out are not available until a relevant action 
is performed. Any commands that have three dots after the name, indicates 
that there is submenu which requires further criteria to be entered.

To the right of the menu commands, keyboard short-cuts are indicated which 
can be used as an alternative way of accessing a particular command.
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Adobe Indesign | Preferences8

InDesign Preferences
Preferences allow you to specify a number of overall 
characteristics for your working document. 

From the InDesign menu, choose Preferences 
(Mac) or Edit > Preferences (PC) and then select 
one of the tab options on the left hand side. If you 
set the preferences with NO document open, these 
will become the default preferences for any new 
documents Useful preferences to change include:

On the Type Options ensure ‘Typographer’s Quotes’ 
is checked and set the number of Recent Fonts to 
Display (default is 10), and choose whether you want 
to drag and drop text editing in layout view..

Units and Increments - these can be set as points, 
millimetres, centimetres. The default is millimetres.

Guides & Pasteboard - By default the Snap to Zone (set 
as on/off within View Menu) enables frames to ‘snap’ or 
‘jump’ to guides placed in a document. The default setting 
of 4 can be too much so, to gain more control, change 

the default Snap to Zone to a preference of 1 or 2.

Display Performance, look for the Greek Below which 
refers to size below which the type is displayed as a grey 
block, the default is below 7pt. On small monitors this 
can present a problem – type that may actually be 9pt 
may be displayed below 7 pt and therefore appears as a 
block. We recommend changing this preference to 2pt

Under File Handling, you can set the Document 
Recovery Data location. Choose the Destination 
folder. Once a file is saved and in the event of a 
system fault, InDesign will upon reboot & automatically 
prompt to recover a saved version of the file

You can also here set how many recent 
files you want to see by default

In time you will find your own preferred method of working 
and can adjust these preferences to suit your working style.

TIP
With no document 

active these 

preferences apply to 

any documents going 

forward, however if you 

change the settings 

with a document open 

the preferences apply 

to only that document.

TIP
You can in fact, 

work in any unit of 

measurement in 

InDesign, simply 

by adding the 

measurements 

abbreviation e.g. 

cm (centimetres), 

in (inches). after the 

value in any field. 
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The InDesign Workspace

Before you begin familiarise yourself with the Workspace, 
the Application Frame, the tools, panels and menus.

Menus 
The Menus contain the commands needed to work in 
InDesign. Many of the Menu commands have shortcuts 
- detailed on the right of each menu command. Some 
menu commands are only available by using Menus.

Properties Panel (Essentials workspace]

This is the primary formatting panel on newer versions 
of Adobe InDesign CC when using the default 
Essentials Workspace. From this one Panel, you 
have quick access to the most common formatting 
options for either text or objects. Use the Window 
Menu to open other specific formatting panels.

Document Border and Margin Guides

Document 
Border

Pasteboard

Pasteboard

Tools

Control Panel Location

Properties, 
Pages and CC 

Libraries

Workspace

Application Frame

Ruler Guides
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Adobe InDesign | Workspace10

Control Panel (essentials classic workspace)

This is the primary formatting panel with icon 
based formatting options which is dependant 
on the type of content selected.

Pages
The Pages Panel allows you to navigate between 
pages, add, remove and sort pages    .

CC Libraries
Creative Cloud Libraries can store assets that are 
created during document production, as well as 
from Adobe Mobile Apps, style sheets ad colours. 
You can create many libraries if required.

Tools
Tools provide the way of selecting, drawing and 
working on elements within a document.

Workspace
The Workspace determines what tools and panels 
are opened when you start a document. There 
7 workspace options each that open panels 
relevant to the type work undertaken.

Choose from, Book, Digital Publishing, Essentials 
Interactive for PDF, Printing & proofing and Typography. 
When other panels are opened, you can also choose 
to customise & create a new workspace.

Essentials is the default.

Panels
Panels provide specific formatting options 
related to the type of content.

The Window Menu deals almost exclusively with showing 
and hiding the various Panels used whilst you work. 
Some Panels are also accessible from menu items, such 
as the Paragraph and Character from Type Menu. 

The Pasteboard
To the left and right of the document page is a work 
space which provides a convenient work area for 
storing design elements which are to be finalised 
prior to moving into the actual document layout. 

Anything within the Pasteboard area will not be 
printed. It is advisable however once a document 
is complete,  to remove objects placed there 
as they do increase the overall file size. 
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Adobe InDesign | Print Terminology

Glossary of Printing Terms
Alignment
Position of text in relation to the box frame.

Ascender
The portion of the text that rises above 
its main body, such as b,d,f,h,t

Additive primary colours
Red, green and blue, which are the three colours used to 
create all other colours when direct, or transmitted, light is 
used (for example, on a computer monitor). They are called 
additive primaries because when pure red, green, and blue 
are superimposed on one another, they create white.

ASCIl
Acronym for American Standard Code for Information 
Interchange. A standard that assigns a unique binary 
number to each text character and control character.

Aspect ratio
The height-to-width ratio.

Attribute
Particular qualities of the text or typefaces.

Auto-Leading
See Leading. In InDesign Auto leading is 20% of the point size.

Background Colour
The colour fill used in the background of a box.

Baseline
The invisible line upon which the bottom of  text is aligned.

Bitmapped image

The simplest type of image. A bitmapped image is 
black and white and formed by a number of dots.

Bleed
A page element (usually colour) that extends 
to the edge of a trimmed page.

Blend
See Gradient Fill.

Box Skew
Boxes in InDesign can be skewed or angled 
using the Modify box option.

Button
A push-button type control in a submenu to 
confirm, activate or cancel and option.

Camera Ready Artwork
A finished page or document ready for reproduction.

Cap Height
The height of a Capital letter measuring from baseline 
to the top of the Capital or uppercase letter.

CMYK image
The four process colours used in printing: Cyan, magenta, 
yellow and black. A four-channel image containing a 
cyan, magenta, yellow and black channel. These are 
known as subtractive, in that when Cyan, Magenta 
and Yellow are combined they produce black.

Colour separation
An image that has been separated into the four process 
colours of cyan, magenta, yellow and black (CMYK), 
and is then printed on four separate plates, each plate 
representing one of the four process colours.

Continuous-tone image
An image containing gradient tones from black to white.

Copyfitting
Determining how much copy will fit in a given space or 
calculating the typeface size based on the amount of 
copy supplied and the number of pages it must fit in.

Crop
To select part of an image and discard the deselected areas.

Crop marks
The marks that are printed near the edges of an image 
to indicate where the image is to be trimmed.
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Adobe InDesign | Print Terminology

Dot gain
In printing a dot can print larger (spread), 
causing darker tones or colours. 

DPI
Dots per inch; a measure of resolution.

Duotone image
A grey scale image that uses one or more inks to 
reproduce highlights and shadows. Duotone mode 
images include monotones (one ink), duotones (two 
inks), tritones (three inks), and quadtones (four inks). 

Emulsion
The photosensitive layer on a piece of film or paper.

Gradient fill
A fill that displays a gradual transition from colour to 
another. Gradient fills are created using the Colour Palette.

Grey scale image
A single-channel image consisting of up to 256 levels 
of grey, with 8 bits of colour information per pixel.

GREP is a command line text search utility originally written 
for Unix, and the acronym means globally search a regular 
expression and print. Essentially, GREP in InDesign allows 
you to use code to find and edit or style text through 
the Find/Change dialogue box or Paragraph Styles.

Halftone
The reproduction of a continuous-tone image, made by 
using a screen that breaks the image into various size dots.

Kern
To adjust the character spacing in type.

Kilobyte
Equal to 1024 bytes. A kilobyte is often referred to a K.

Leading
The line spacing for type, measured from 
baseline to baseline of the lines of text.

Linear fill
A fill that is projected from one point 
to another, in a straight line.

LPI
Lines per inch; a measure of resolution.

Moiré Pattern
An undesirable grid like pattern that can result when two 
or more screens are superimposed when printing.

Nudge
Active items can be nudged in 1 point increments using 
the arrow keys on the keyboard. Hold the option key 
down whilst nudging to move in .1 point increments.

Offset Lithography
A printing process that uses metal plates for each colour of 
a spot colour or 4 plates for a process colour document.

Pantone Colours
An International standard for specifying spot colour or 
process colour jobs that match pre-mixed inks (spot).

Pasteboard
The non-printing area surrounding the document page.

Pica
Unit of measurement used in typography. There 
are size picas to an inch, 12 points to a pica.

Point
A basic unit of typographical measurement. A 
point is approximately 1/72 of an inch.

Postscript
A page description language developed by Adobe 
Systems Inc. Postscript is used to describe the 
fonts, graphics and layout in printing process.

Process Colour
The four colour method of reproducing all colours from 
only four inks, Cyan, Magenta, Yellow and Black.

RAM
Random Access Memory, fast computer memory 
that stores information temporarily.

Registration Mark
Symbols placed on artwork or film to ensure 
precision alignment in the printing process.
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Adobe InDesign | Print Terminology

Resident Font
A font that is stored in the printers memory.

RGB image

Red, green, blue, this is the default image mode on Flatbed 
scanners and monitors  RGB are known as additive colours, 
that is when each colour is overlaid they produce white.

Smart Quotes
The curly quotation marks that are typographically correct.

Thumbnail
A reduced view of a page - traditionally the 
thumbnail would be a quick sketch an designer 
might make to outline a possible layout.

TIFF
Tagged image format File. Picture files either 
black and white, greyscale  or colour.

Tiling
The process by which a document larger than 
the paper it can be printed on can be split into 
sections and then assembled manually.

Tracking
The overall spacing on selected text. By specifying negative or 
positive values the overall character spacing can be adjusted.

Trapping
A slight overlapping that prevents gaps from appearing 
along the edges of an object during the printing process.

Trim
Refers to the process of cutting the edges from the printing 
press sheets to produce the finished ‘trimmed’ page.

Type Family
A group of related typefaces.

Widow
Refers to the last line of a paragraph that falls at the 
top of a column – at all costs to be avoided.

Word Space
The amount of space between words based on the 
widths specified by the typeface designer. InDesign 
provides methods for adjusting word space. 
(Hyphenation, Justification, Kerning and Tracking).

WYSIWIG
An acronym for What You See Is What You Get. 
It refers to the screen displays that accurately 
displays the look of the final printed page.

X-Height
The height of the lowercase characters in a 
typeface as measured from the baseline.
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Adobe InDesign | Resources

InDesign Resources
Layers Magazine
Layers is the “How-to magazine for everything Adobe”, 
which has a brilliant section dedicated to InDesign. Here 
you can learn how to use liquid layout, dot-dash stroke, 
story editor and much more. And, best of all, it’s free! 

http://layersmagazine.com/category/InDesign

Computer Arts
The world’s best-selling magazine for digital artists and 
designers Computer Arts runs regular news, tips and 
tutorials on InDesign. The Computer Arts channel also has a 
focuses on the software, with regular features on InDesign 
plug-ins, how to improve your skills and much more. 

http://www.creativebloq.com/computer-arts-magazine

Adobe Creative Cloud - InDesign
Adobe Creative Cloud now provides online 
video based tutorials on all the software.

https://helpx.adobe.com/uk/indesign.htm

Inspire Online
Adobe’s own resources centre with some very useful 
scripts and tutorials, actions and plug-in information

http://inspire.adobe.com/

tv.adobe.com/channel/design/
Adobe TV Channels covering all subjects including Design

www.creativesuitepodcast.com
Some useful FREE tutorials, Videos and more Adobe 
Evangelist, Terry White, now focusing on the Creative 

Cloud TV. Free tutorials on InDesign and lots more..

Other Useful Resources
fontsquirrel.com
Completely free commercial fonts for 
designers, even for commercial use!

Adobe Colour
Formerly Kuler this is a great free tool for creating, 

editing and sharing. https://colour.adobe.com

Adobe Fonts
Formerly Typekit. A library of fonts available for instant preview 

and download. Included in the complete Creative Cloud license..

Adobe Stock
A library of 1000s of images and video for preview and download. 
Available by subscription from£19.99 pm for 10 

images & with rollover per month if unused..

www.creativepro.com
Creative community where you can subscribe to 
email news on various subjects and topics.

You can also subscribe to receive various online 
versions of magazines such as DIGIT, Macworld, 
MacUser, Computer Arts and more.
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